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Ten tips for chart
e n I S Or C a r S Hello, and welcome to Mark’s Excel
After going through these ten charting tips, you'll Tips. In this article, | will show you the
be faster and more efficient than ever before. sixth tip, in a series of 10, tips for Excel
charts. After going through these ten
charting tips, you’ll be faster and more
efficient than ever before. You can find
the links to each of these 10 Excel tips
at the bottom of this article. Let’s get
E started.
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N Tip #6: Create multi-level labels.
3
4 o Wouldn't this chart o In cell G14, type the o Select™sg chart, and o With the dialog box open,
3 be better if it had word "Fruits." And in then on the Dugjgn drag to select cells G13 to This only works if your rows
6 another level of cell G17, type the tab, click Select 118 (from Department to are already organized in
7 labels at the bottom, word "Vegetables." Data. 1,000). Click OK. Now the groups. In the example
8 that organized the slart has another level of below, the rows for fruits
9 columns by either label3™NQQ "Fruits" and are grouped together, and
10 "Fruits” or "Vegetables. SO are the rows fDr
1 "Vegetables"? vegetables.
12
13 Department |Product Amount
14 Apples 500
15 Oranges 800
16 . l l . Bananas 800
17 Asparagus 600
18 Apples Oranges Bananas Asparagus Broccoli Broccoli 1000
19
20
21 .
22 2 . 0
)3 Tip #6: Create multi-level labels.
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N Tip #6: Create multi-level labels.
3
4 o Wouldn't this chart o In cell G14, type the o Select the chart, and o With the dialog box open,
3 be better if it had word "Fruits." And in then on the Design drag to select cells G13 to This only works if your rows
6 another level of cell G17, type the tab, click Select 118 (from Department to are already organized in
7 labels at the bottom, word "Vegetahles." Data. 1,000). Click OK. Now the groups. In the example
8 that organized the chart has another level of below, the rows for fruits
9 columns by either labels for "Fruits" and are grouped together, and
10 "Fruits” or "Vegetables." SO are the rows fDr
o "Vegetables"? vegetables.
12
13
14 Apples 500
15 Oranges 800
16 . l l . Bananas 800
17 Asparagus 600
Apples Oranges Bananas Asparagus Broccoli .
18 Broccoli 1000 1 o oo o
0 Wouldn't this chart be better if it had
if <: another level of labels at the bottom,
Previous Next . .
2 3 that organized the columns by either
23 n g || n n
. Fruits" or "Vegetables"?
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N Tip #6: Create multi-level labels.
3
4 o Wouldn't this chart o In cell G14, type the o Select the chart, and o With the dialog box open,
3 be better if it had word "Fruits." And in then on the Design drag to select cells G13 to This only works if your rows
6 another level of cell G17, type the tab, click Select 118 (from Department to are already organized in
7 labels at the bottom, word "Vegetables." Data. 1,000). Click OK. Now the groups. In the example
8 that organized the chart has another level of below, the rows for fruits
9 columns by either labels for "Fruits" and are grouped together, and
10 "Fruits” or "Vegetables." SO are the rows fDr
o "Vegetables"? vegetables.
12
13 Nanartmant |Product Amount
15 Oranges 800
16 . l l . Bananas 800"
17 Asparagus 600
18 Apples Oranges Bananas Asparagus Broccoli Broccoli 1000
19
20
21 .
<ﬁ Previous Next $>
22 n e
’3 In cell G14, type the word "Fruits.
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N Tip #6: Create multi-level labels.
3
4 o Wouldn't this chart o In cell G14, type the o Select the chart, and o With the dialog box open,
3 be better if it had word "Fruits.” And in then on the Design drag to select cells G13 to This only works if your rows
6 another level of cell G17, type the tab, click Select 118 (from Department to are already organized in
7 labels at the bottom, word "Vegetables." Data. 1,000). Click OK. Now the groups. In the example
8 that organized the chart has another level of below, the rows for fruits
9 columns by either labels for "Fruits" and are grouped together, and
10 "Fruits" or "Vegetables." so are the rows for
1 "Vegetables"? vegetables.
12
13
14 Fruits Apples 500
15 Oranges 800
- m B 0 =
17 | Vegetables Repazag
18 Apples Oranges Bananas Asparagus Broccoli Eraaealt 968
19
20
22 o
23 And in cell G17, type the word

n n

24 Vegetables.
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N Tip #6: Create multi-level labels.
3
4 o Wouldn't this chart o In cell G14, type the o Select the chart, and o With the dialog box open,
3 be better if it had word "Fruits." And in then on the Design drag to select cells G13 to
6 another level of cell G17, type the tab, click Select 118 (from Department to
7 labels at the bottom, word "Vegetables." Data. 1,000). Click OK. Now the
8 that organized the chart has another level of
9 columns by either labels for "Fruits" and
10 "Fruits" or "Vegetables."
"Vegetables"?
11
12 c\ ' ’) —n
13 i ¥ ) S epartment | Product .m'l
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15 | Oranges 800
16 Q . l l . Q Bananas 800
17 ? Vegetables Am‘\ﬁ[)ﬂ
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N Tip #6: Create multi-level labels.
3
4 o Wouldn't this chart o In cell G14, type the o Select the chart, and o With the dialog box open,
5 be better if it had word "Fruits." And in then on the Design drag to select cells G13 to This only Works if your rows
6 another level of cell G17, type the tab, click Select 118 (from Department to are already \ganized in
7 labels at the bottom, word "Vegetables." Data. 1,000). Click OK. Now the groups. In the\gxample
8 that organized the chart has another level of below, the rows
9 columns by either labels for "Fruits" and are grouped togetNer, and
10 "Fruits" or "Vegetables." 50 are the rows for
0 "Vegetables"? vegetables.
12 o ~ 0 e —=
3 9 0 AR iment Product  [Amount |
14 ruits Apples 500
15 o o 4 Oranges 800
16 . l l . Bananas 800
17 ? Vegetables |Asparagus 600
18 Apples Oranges Bananas Asparagus Broccoli —|- Broccoli 1000
O O 0
19
20
21 :
Previous Next

22 q
s And then on the Design tab.
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M Tip #6: Create multi-level labels.
3
4 o Wouldn't this chart o In cell G14, type the o Select the chart, and o With the dialog hox open,
3 be better if it had word "Fruits." And in then on the Design drag to select cells G13 to
6 another level of cell G17, type the tab, click Select 118 (from Department to
7 labels at the bottom, word "Vegetables." Data. 1,000). Click OK. Now the
8 that organized the chart has another level of
9 columns by either labels for "Fruits" and
10 "Fruits" or "Vegetables."
"Vegetables"?
11
12 0 ~ 0o —_— .
3| 9 ° NP ®ocpariment Product  [Amount |
14 ruits Apples 500
15 o o 4 Oranges 800
16 . l l . 1 Bananas 800
17 ? Vegetables |Asparagus 600
18 Apples Oranges Bananas Asparagus Broccoli —|- Broccoli 1000
O O 0
19
20
21 -
Previous Next
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This only works if your row
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3 @Add @Edit > Remove @Edi;
4 o Wouldn't this chart o In cell G14, type the o Select the chart, and o With the dialog box open, Amount Fruits Apples
5 be better if it had word "Fruits." And in then on the Design drag to select cells G13 to Fruits Oranges
6 another level of cell G17, type the tab, click Select 118 (from Department to Fruits Bananas
7 labels at the bottom, word "Vegetables." Data. 1,000). Click OK. Now the Vegetables Asparagus
8 that organized the chart has another level of B Vegetablest i
9 columns by either labels for "Fruits" and - egetavles Broccal
"Fruits" or "Vegetables."

10 "Vegetables"? Hidden and Empty Cells Cancel
11
12
13 Department |Product Amount
14 IFruits Apples 500
15 - . . - . i Oranges 800
16 I Bananas 800}

Apples Oranges Bananas Asparagus Broccoli 1
17 | Vegetables .Asparagus 600!
18 Fruits Vegetables T Broccoli & 1000}
19
20
21 :
22 q q
’3 With the dialog box open, drag to select
e cells G13 to 118 (from Department to
25

1,000).
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2 TI p #6: create mUItI-IEVEI Iabels' Legend Entries (Series) Horizontal (Category) Axis Labels
3 @gdd @Edit > Remove @Edt
4 o Wouldn't this chart o In cell G14, type the o Select the chart, and o With the dialog box open, Amount Fruits Apples
3 be better if it had word "Fruits." And in then on the Design drag to select cells G13 to Fruits Oranges
6 another level of cell G17, type the tab, click Select 118 (from Department to Fruits Bananas
7 labels at the bottom, word "Vegetahles." Data. 1,000). Click OK. Now the Vegetables Asparagus
8 that organized the chart has another level of 8 . ;
9 columns by either labels for "Fruits" and @ Vegetables Braccall
10 "Fruits" or "Vegetables."
"Vegetables"? Hidden and Empty Cells oK [ Cancel

11
12
13 Department |Product Amount
14 iFruits Apples 5[)[)!
15 . . . H Oranges 800]

] [] : : :
16 [ Bananas 8001

Apples Oranges Bananas Asparagus Broccoli I
17 | Vegetables .Asparagus 6[][]:
18 Fruits Vegetables L____________BIEEE':_’E ___________ 1 _D_D_DJ'
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M Tip #6: Create multi-level labels.
3
4 o Wouldn't this chart o In cell G14, type the o Select the chart, and o With the dialog hox open,
3 be better if it had word "Fruits." And in then on the Design drag to select cells G13 to This only works if your rows
6 another level of cell G17, type the tab, click Select 118 (from Department to are already organized in
7 labels at the bottom, word "Vegetables." Data. 1,000). Click OK. Now the groups. In the example
8 that organized the chart has another level of helow, the rows for fruits
9 columns by either labels for "Fruits" and are grouped together, and
10 "Fruits" or "Vegetables." 50 are the rows for
1 "Vegetables"? vegetables.
12 0 - 0 — .
3§ 0 NI, cartment Product  [Amount |
14 ruits Apples 500
15 . . Oranges 800
o N || olZ
16 Aol o . A o i Bananas 800
17 PRI — — e et ? Vegetables |Asparagus 600
18 5 Fruits Vegetables 5 Broccoli 1000
e
19
20
21 .
Previous Next =
22
)3 Now the chart has another level of
] || n ]
2 labels for "Fruits" and "Vegetables.
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M Tip #6: Create multi-level labels.
¥
4 o Wouldn't this chart o In cell G14, type the o Select the chart, and o With the dialog box open,
5 be better if it had word "Fruits." And in then on the Design drag to select cells G13 to This only works if your rows
6 another level of cell G17, type the tab, click Select 118 (from Department to are already organized in
7 labels at the bottom, word "Vegetables." Data. 1,000). Click OK. Now the groups. In the example
8 that organized the chart has another level of helow, the rows for fruits
9 columns by either labels for "Fruits" and are grouped together, and
10 "Fruits” or "Vegetables." SO are the rows fDr
0 "Vegetables"? vegetables.
12
13 Department Product Amount
14 Fruits
: = B B = B
10 Appl o] B A B li
17 pples ranges ananas sparagus roccoli Vegetables
18 Fruits Vegetables . . . . .
o One thing to keep in mind is this only
20 works if your rows are already
21 : . 5
5 <:: Previous organized in groups. In the example
23 below, the rows for fruits are grouped
24
25 together, and so are the rows for .
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Website Links For 10 Tips For Excel Charts: .
]
Te n 't I p S fo r C h a rts Tip # 1: Press ALT+F1 to quickly make a chart
After going through these ten charting tips, you'll Tip # 2: Select specific columns, before creating a chart
be faster and more efficient than ever before. Tip # 3: Use a table with a chart
E I Tip # 4: Quickly filter data from a chart
XCE Let's go >
Tip # 5: Use PivotCharts when your data isn't summarized
Tip # 6: Create multi-level labels
¥
MAR K S Tip # 7: Use a secondary axis to create a combo chart
EXCEL TI PS Tip # 8: Hook up a chart title to a cell
. Tip # 9: Split off slices into a second pie
SIMPLE & EASY TO FOLLOW HOW TO VIDEOS
Tip # 10: Hover over chart elements to get a preview Y
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https://marksexceltips.com/2023/10/25/ten-tips-for-excel-charts-tip-1-press-alt-f1-to-quickly-make-a-chart/
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https://marksexceltips.com/2023/10/25/ten-tips-for-excel-charts-tip-3-use-a-table-with-a-chart/
https://marksexceltips.com/2023/10/26/ten-tips-for-excel-charts-tip-4-quickly-filter-data-from-a-chart/
https://marksexceltips.com/2023/10/26/ten-tips-for-excel-charts-tip-5-use-pivot-charts-when-your-data-isnt-summarized/
https://marksexceltips.com/2023/10/26/ten-tips-for-excel-charts-tip-6-create-multi-level-labels/
https://marksexceltips.com/2023/10/26/ten-tips-for-excel-charts-tip-7-use-a-secondary-axis-to-create-a-combo-chart/
https://marksexceltips.com/2023/10/26/ten-tips-for-excel-charts-tip-8-hook-up-a-chart-title-to-a-cell/
https://marksexceltips.com/2023/10/26/ten-tips-for-excel-charts-tip-9-split-off-slices-into-a-second-pie/
https://marksexceltips.com/2023/10/26/ten-tips-for-excel-charts-tip-10-hover-over-chart-elements-to-get-a-preview/

View This Tutorial On My Website

View The Video Tutorial Here

Visit My YouTube Channel
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EXCEL TIPS

SIMPLE & EASY TO FOLLOW HOW TO VIDEOS



https://marksexceltips.com/2023/10/26/ten-tips-for-excel-charts-tip-6-create-multi-level-labels/
https://marksexceltips.com/2023/10/26/ten-tips-for-excel-charts-tip-6-create-multi-level-labels/#video-tutorial:~:text=View%20the%20Video%20Tutorial.
https://www.youtube.com/@marksexceltips4312/videos
https://www.youtube.com/@marksexceltips4312/videos
https://www.youtube.com/@marksexceltips4312/videos

